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1. Introducing 
 IP ChangeOver has been developed for professionals who operate DVB headends. The 
device can simultaneously monitor 32 IP streams. If an error is detected, the device changes 
the source of the Output from Main input to the Reserved input and at the same time sends an 
SNMP message indicating the error. After the fault has disappeared, the device will switch 
back to the original stream. 

Ordering data: 

CW-6040 IP ChangeOver 19” rack version 

CW-6041 IP ChangeOver portable version 

 It is possible to use the device just for sending SNMP so that it does not switch over when 
detecting a faulty stream but sends an SNMP message about the error. The ChangeOver 
modules can also be used as manual or remote control switches. The built-in clock can be 
synchronized with the SNTP server and allows the ChangeOver to be controlled by clock. The 
fault detection modules of the device also provide information about their status via a parallel 
port, and in the event of a fault, a voltage of 3.3V appears at a given pin of the port. 

 We hope that by presenting these ideas, we have been able to draw our users’ attention to 
the possible usage of IP ChangeOver device. Our system builders are available to discuss 
further details on phone (numbers on our website at www.cableworld.eu) or via email at 
cableworld@cableworld.hu. 

 

     CableWorld team 

1.1. Start-up 
 IP ChangeOver is available in portable and rack frame version. After unpacking the 
device, take care of the power supply first. For rack devices, the network cable is included with 
the package. The portable version can be operated from an external + 12V / 1A power supply. 
The external power supply is supplied as an accessory. 

 The power switch is located on the back of the rack version device. The portable version 
does not have a power switch, the device is turned on as soon as the external power supply is 
connected to the device. 

 At the front of the rack version devices, an E-ink display was placed. During operation, 
various parameters can be seen by pressing the button. When the device is turned off, the 
display shows the IP address of the Management Port. 
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 Use a cross cable to connect the device to your computer (the cable is included). If there is 
a Network Switch between the device and your computer then use a straight cable. The 
Management Port is separated from the TS Port. The IP Address of the Management Port is 
192.168.10.10 by default. Type this IP address in the browser address bar to load the user 
interface of the device. The IP address of the TS Port is 10.123.13.102. 

 The datasheet of the device contains the technical data and can be downloaded from our 
website (www.cableworld.eu). 

 CableWorld is pleased to see if a user attempts to insert the device into their system or 
write their own software to control the device. CableWorld provides support to creative users, 
with instruction sets of the device, and advanced users can even get source code. The Ethernet 
interface of the device, in addition to HTTP, also allows user to use UDP packets to control the 
device. 

 We welcome the comments and measurement results related to the devices and take them 
into consideration in our further developments. 

1.2. Web-based user interface 
A web browser is required to display the user interface. We highly recommend that use 

Firefox web browser because the appearance of the user interface may be different for other 
browsers, and we cannot guarantee the correct operation. 

 The menu is on the left side of the user interface. An orange line at the end of the menu 
indicates that which menu is selected. If there are several submenus in the given menu item, 
the top submenu will be opened first (see Figure 1). 

Figure 1 
The ChangeOver menu tree 

 
 The available settings in the menus will be described in detail in the following chapters of 
the manual. When you edit the data of an entry window, the background of the entry window 
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changes to yellow, indicating that the data has been modified. The new data is processed by 
hitting the "Enter" key or leaving the entry field. 

 Note that the connection between the hardware and the user interface is not permanent. 
All data is stored in the user interface software until you click the [Apply] button when the 
data is saved to the hardware. 

 Clicking the -Refresh icon the user interface shows the current settings of the device. 
The configuration can be saved in the device memory by clicking the [Save] button. The Project 
menu allows you to save various configurations to a file or to restore our previously saved 
configuration from a file.  

1.3. Frequently Asked Questions 

How to reach the User Interface? 

The default IP address of the Management Port of the device is 192.168.10.10, the network 
mask is 255.255.255.0. Connect the management port and your computer with a cross cable 
(included accessory), or use straight cable if there is a network switch between the device and 
your computer. Our computer and the device has to be in the same network (ex. our 
computer’s IP address is 192.168.10.11). Use Firefox web-browser, and write the device’s IP 
address to the browser’s address bar. 

What should I do if my device is not found on the 192.168.10.10 IP address? 

We may not know the IP address of the device. Since the device sends an ARP message to the 
network every 15 ... 60 seconds (adjustable), we can find out the IP address of the device with 
for example Wireshark network packet analyser software. 

If it does not help us to find the device, press the Reset button on the back of the device that 
restores the IP address to 192.168.10.10/24. At this address, the software also disables 
Password protection.  

How do I delete my programs and restore the original factory settings? 

It is important not to use the Reset button on the back because it resets only the IP addresses 
and some hardware module settings. 

The [Project] menu of the software contains functions for deleting configurations and restoring 
the factory settings. 

What to do if I have configured several IP inputs, but I see that only the IP Input 1 signal is 
displayed and its data rate is quite high. 
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 It is very likely that IP and Port Filters are not switched on, so the first IP input will receive all 
the input streams. In the [ChangeOver Settings/Advanced Settings] menu, the Destination IP 
Filter and Destination Port Filter check boxes have to be ticked. 

2. Home 

 Selecting the [Home] menu gives a summary of the settings of the ChangeOver modules. 
The parameters cannot be changed here. The Home menu is shown in Figure 2. 

 

Figure 2  
The [Home] menu 

 
 Every ChangeOver configuration is shown in one row and four column. The first column 
is the Input part. After the IP address and Port number, a green (Main Input) or yellow 
(Reserved Input) indicator is displayed when the given IP input is on. If the IP address is 
invalid, a red indicator can be seen on the left side. The second column shows which input is 
connected to the output and which parameters are used for switching. The third column shows 
the output. The set output IP address can be seen and a green indicator shows if the output 
streaming is on. The fourth column shows if the SNMP message sending is switched on. 
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3. ChangeOver Settings 

 The changeover modules can be set in the [Changeover Settings] menu. By selecting the 
[Basic Settings] submenu, the most frequently used parameters can be set. In the [Advanced 
Settings] submenu, the user has the option to display additional settings. 

 To select one of the 32 changeovers, click one of the rows of the selector on the right side. 
The first column indicates green if the Main input and yellow if the Reserved input is enabled. 
The second column shows the number of the given ChangeOver. The third column shows the 
set conditions with a few characters. The fourth column is displayed green when the output is 
enabled. Figure 3 shows the selector. 

Figure 3  
ChangeOver selector 

 

3.1. Basic Settings 
 To configure IP inputs and IP output, select the [Basic Settings] submenu and enter the IP 
Address: Port Number data and enable the streams with the On-Off switch. Main IP Input 
Settings contains the settings for the primary IP input, and Reserved IP Input Settings contains 
the settings for the backup IP input. You can set the output in the IP Output Settings section. 

 You can write any text in the User Identifier window. The device stores this text only if 
you save the settings to the flash memory by clicking the [Save] button. 

 By clicking on the -Refresh icon on the page, the software reads all 32 changeover 
configurations from the device and displays it. 

 After configuring the inputs and outputs, the switching parameters also have to be 
configured. Figure 4 shows the switching parameters configuration.  
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Figure 4 
Switching parameters configuration 

 
 By selecting the checkbox of the manual control, the main or the reserved input can be 
connected to the output. The source can be selected by the switch. If the switch swiped to left 
(the background of the switch is green) then the Main input is connected to the output. If the 
switch swiped to right (the background of the switch is yellow) then the Reserved input is 
connected to the output. If you select manual mode, you cannot set any additional switching 
condition. 

 The Data Rate less than module monitors the data rate of the Main input and switches to 
the Reserved input if the data rate is less than the specified limit. Measurement is based on 
seconds. 

 The RTP Errors more than module monitors the order of RTP data packets. The module 
switches to the Reserved input when it detects the same or more errors in the header of the 
RTP packet in a second than we set. Typically, a small number (1, 2, 3, etc.) has to be entered 
for this parameter. 

 The CC errors more than module checks the number of CC (Continuity Counter) errors. 
The module switches to the Reserved input when the number of CC errors in 1 second is more 
than the set limit. The number of CC errors is determined as the sum of errors occurring in 
elementary streams. It is not advisable to specify a very small number as a limit value. 

 The Scrambled at PID module analyses the incoming packets at the given PID. If one or 
more packets are encrypted then the module switches to the Reserved input. The module 
switches to the backup source even if no packets arrive at the given PID (e.g. the CAM is 
broken). 

 The PID Presents module monitors the presence of a given PID and notifies us if no 
packets arrive within a given time. The module can be used for monitor the presence of an 
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external stream like EPG or can be used for Null packet monitoring. The lack of null packets 
could mean an overflow in the MPTS streams. 

 In the case of RF (DVB-T/T2/S/S2/C) reception, the TEI (Transport Error Indicator) bit is 
set to 1 if the error correction circuit could not correct all errors. The TEI Errors module checks 
how many TS packets were found in 1 sec that had a TEI bit set to "1" and switches to the 
Reserved Input if the number of errors exceeds the specified limit. 

 In the case of simultaneous use of measuring modules, the device switch from the Main 
Input to the Reserved Input if any of the set condition is met. 

 Timed switching module can be enabled by selecting the checkbox. All of the other 
modules will be switched off if we use Time controlled switch module. To configure the 
module, click on "Time controlled switch" text. The appearing surface can be seen in Figure 5. 

 

Figure 5 
Time controlled switch module configuration 

 
 Select the days and time (format: hh:mm:ss) when the switching is needed. The Time 
controlled switch set the input from Main to Reserved in the given time for a given duration. 

Note that the device's internal clock is synchronized over the Internet to the specified 
SNTP server. The clock must be configured in the [Device] menu. When no clock is required, 
we recommend turning off the SNTP clock synchronization by deleting the IP address from 
the Time server IP address entry field. 

During the configuration process the parameters are only stored in the user interface 
software. Not to forget to click on the [Apply] button to save your settings into the memory of 
the device. Clicking the [Apply] button saving the all ChangeOver settings. 

The configuration stored in a file can be loaded into the device in the [Project] menu or the 
current configuration can be saved to an external file there. 



 10    
 

3.2. Advanced Settings 
 In the [Advanced Settings] submenu, any input and output parameters can be set. Figure 
6 shows the window that appears when you select the advanced settings menu. 

 

Figure 6 
The Advanced Settings menu 

 
 The Main and Reserved IP inputs can be filtered by the source IP address and Port 
number. IGMPv3 protocol can be enabled here. Check the checkbox to remove VLAN tag and 
write the VLAN ID into the VLAN Identifier entry field. 

 The number of TS packets added to a UDP packet can be set here. By default 7 TS packet 
will be added but the number can be set between 1..7. VLAN tag can be added to the Output 
stream by filling the entry field. If VLAN Tag is not needed, just clear the entry field and the 
VLAN mode will be switched off. 

In the case of multicast streaming, the software automatically calculates the MAC address. 
In case of Unicast streaming, the device will try to find the MAC address associated with the 
IP address. If the device does not find the MAC address, then it must be given manually or the 
search must be repeated. 
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4. SNMP -Trap Settings 
 SNMP messages consist of UDP packets. The communication port of SNMP trap message 
is port 162 while port 161 is reserved for SNMP data request.  

The unique identifier of CableWorld is (OID – Object Identifier) 29143. The identifier was 
given us by IANA (Internet Assigned Numbers Authority). 

The IP ChangeOver device is able to send SNMP Trap messages in the following cases: 
 

• TS port link is down 

• Power supply level is out of range of +3,15 V .. 3,45 V 

• The temperature of the device is +65 C°or more 

• Any IP ChangeOver module switch to reserved input 

• Any IP ChangeOver module switch back from reserved input to main input 

 

 The SNMP trap message contains the reason why the switchover happened. The structure 
of the message is included in the MIB file what can be downloaded from our website. 

 In the [ChangeOver Settings] menu the SNMP sending can be enabled and disabled 
individually for each module (see Figure 7). The conditions under which the device will send 
the SNMP Trap message can be set in here. 

 In the [SNMP-Trap Settings] menu the IP address of the server can be set. The device can 
send Trap messages to two SNMP servers. Enter the IP address of the server and select MAC 
Auto mode. The device then requests the MAC address of the server by sending an ARP 
message. By selecting manual mode, we can specify the MAC address of the SNMP server. The 
interface can be seen in Figure 7. 
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Figure 7 
Configuration of the SNMP trap message 

 
Note that the device will send an SNMP message only if the server's IP address is set in 

the [SNMP-Trap Settings] menu and trap sending is enabled for the given ChangeOver in the 
[ChangeOver Settings] menu. 

  

5. Diagnostic 
 The [Diagnostic] menu gives us information of the operation of the device.  

5.1. Diagnostics 

 In the Diagnostics submenu by clicking on the -Refresh icon, the software reads and 
displays the current status of the 32 ChangeOver. 

The data rate of the IP inputs and outputs can be seen after the IP addresses. On the right 
side of the interface, in the ChangeOver State column, a green signal indicates if the main input 
is connected to the output and a yellow signal warns when the backup signal is connected to 
the output. In addition, there are some abbreviations that inform you what has caused the 
switching (DR=Data Rate, CC=Continuity Counter error, $=scrambled, TEI=Transport Error 
Indicator, Time, RTP=RTP sequence error). Figure 8 shows the [Diagnostics] submenu. 

Marking the Repeated Refresh checkbox the interface will be refreshed automatically. To 
stop the readout process, remove the checkmark from the checkbox. Leaving the menu will 
automatically stop the refreshing. 
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Figure 8 
The Diagnostics submenu 

5.2. Control Report 
 Control Report is designed for users who are interested in details of operating processes. 
The first six columns of the interface show the set limits of the switching control modules and 
the actual values measured at the time of the update. The rightmost column shows the status 
of the switch (green=Main input, yellow=Reserved input). In case of switch-over in the “Back 
off Time” column we can see a value (the time in seconds) what shows how long the Main 
input has to be fault-free before the switch-back occurs. After the fault has disappeared, the 
number shown in the column starts decreasing until it is reach zero and the device switches 
back to Main input. See Figure 9 for details on the display area of the Control Report. 

 

Figure 9 
The Control Report 

 
 In case of the Repeated Refresh checkbox is checked the browser become quite busy due 
to the large amount of data processing and mouse click may occasionally not be detected (for 
example, it does not change the menu). In this case, repeat the mouse clicks several times or 
uncheck the Repeated Refresh checkbox. 
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5.3. Control Port 
 On the Control Report page the State shows the status of the switch (green=Main input, 
yellow=Reserved input).  

 The State signal can be used to control 3rd party devices as the first 16 ChangeOver 
module’s state signal is connected to an alarm connector located at the back of the device. The 
rack version device has 25-pin connector at the back while the portable version uses two 9-pin 
connectors.  

 The output signal becomes high (3.3 V) in case of a switch-over to reserved input. The 
signal is provided by 2 pcs of CD74HC595 SMD integrated circuit without any protection 
against the external disturbances hence be careful when using them. The wire diagram of the 
connector is shown in Figures 10 and 11. 
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Figure 10 
25-pin alarm port connector 
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Figure 11. 
9-pin alarm port connector 
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6. Device menu 
The following can be set in the [Device] menu: Management Port and TS Port 

parameters, Time server settings and the password protection. Additionally, the firmware 
upgrade files can be upload and the settings of the device can reset to default here. 

6.1. Basic Settings 
 After modifying the IP address of the Management Port the new IP address have to be set 
in the browser's address bar. 

Erasing the Gateway IP Address stops looking for the gateway on the network. Only enter 
the Gateway IP Address, if there actually is a gateway on the network. The search of the 
Gateway fills the network with unnecessary data packets. 

We suggest the usage of the DHCP mode to expert users only. If we use DHCP then we 
need access to the server in order to find out what IP address was given to the Management 
Port and TS Port.  

6.2. Advanced Settings 
 In the Advanced Settings menu the MAC address of the device and the ARP and IGMP 
membership report repetition time can be modified. 

The Management Port of the device shows its presence to the network by sending ARP 
messages. The use of the value between 15 … 60 seconds is usually suitable. The sending 
process can be stopped by entering 0, but we really do not suggest to do so.  

For the long and fluent receive of the multicast data streams, the device periodically sends 
IGMP messages. Setting the IGMP Repetition Time value between 60 … 180 seconds is optimal. 
Turning it off is not expedient, but attainable by entering 0. 

 Clicking on the [Device Reset] button, the software will restart the device. We put this 
button on the interface for helping the remote restart function.  

 Clicking on the [Device Diagnostic] button, the software will read the attributes of the 
device, then it arranges them into a chart, and displays it on a new page. 

6.3. Timer Server Settings 
 The built-in clock starts with the value '00' when turning on the device but it can be 
synchronized with an SNTP (Simple Network Time Protocol) server if the Management Port 
is online. If you don't want to synchronize the built-in clock with a time server, leave the SNTP 
server IP Address field blank to stop the synchronization process. 
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 SNTP servers provides the Coordinated Universal Time (UTC) with leap seconds added 
at the port number of 123. They can be in the same network as the Management Port is but 
they usually aren't. Let's see the steps of the synchronization process below. 

 The device sends an ARP message in order to get the MAC address of the time server  
 To reach an external SNTP server a gateway is required which manages the 

communication between the server and the device. 
 After getting the MAC address, the device attempts to synchronize its clock with the 

reference one every five seconds. If the synchronization succeeds, it will be repeated 
every ten minutes. 

o 152.66.0.1  BME 
o 148.6.0.1  KFKI 
o 216.239.35.8 Google 

 The process of searching the time server's MAC address can be disabled by choosing the 

manual MAC address mode. Click the -Refresh icon to see the state of the synchronization 
process. 

 As SNTP servers provide coordinated universal time, the deviation in geographical 
location and daylight saving time (DST) have to be set by the user. The time server settings of 
the user interface are shown in Figure 12. 

 

Figure 12 
The configuration tab of the Time Server 
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6.4. Password Settings 
 The software let us protect our settings against unauthorized people, and display the 
below tabs only. 

 Home -Settings 
 Diagnostic 
 Help 
 About 

To enable the password protection, check the Use Password checkbox on the 
[Device/Password Settings] page, enter the same password twice, and click the [Apply] 
button. The password settings tab is shown in Figure 13. 

 

Figure 13 
The Password Settings tab 

 To disable the password protection, uncheck the Use Password checkbox, and click the 
[Apply] button. Please note that the password protection is automatically disabled if the IP 
address of the management port is 192.168.10.10/24 or 10.123.13.101/8. 

6.5. Upgrade 
 The firmware and the user interface of the device can be upgraded (or downgraded) 
through the management port. Click the [Browse] button on the [Device/Upgrade] page, 
choose the file to be loaded, and click the [Start Software Upgrade] button. The upgrade 
usually takes a few minutes depending on the size of the file. At the end of the upgrading 
process, the browser automatically refreshes the page. 

6.6. Factory Settings 
 Adjusting the factory settings is not allowed. This page is available for developers only. 
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7. Project menu 
 In the [Project] menu, you can give your project a text identifier which can be stored in the 
flash memory of the device together with all the input and output identifiers by clicking the 
[Save] button. This project identifier, which is IP ChangeOver by default, will be displayed in 
the header of your browser. The Project page is shown in Figure 14. 

 

Figure 14 
The Project page 

Clicking the [Open] button, the user interface displays the project which is stored in the flash 
memory. To apply these settings, click the [Apply] button. 

Clicking the [Save] button, the running project will be saved in the flash memory. This button 
is available on the ChangeOver Settings page, too. 

The project can be saved in or loaded from a Base64-encoded XML file. 

The Project Editor lets you 
- load only the input/output settings from a file, 
- erase only the ChangeOver settings, 
- erase all the settings and load the factory defaults. 

To apply the above operations, click the [Apply] button. This button is available on the 
ChangeOver Settings page, too. 
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8. Help 
 In the Help menu, you can find not only the user manual of the device but also an extract 
of this. 

9. About 
 The first menu give you information about the released software versions. The second one 
is a link to CableWorld's homepage. 


